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CHAPTER 1

Installing the Virtual Appliance

This chapter includes the following topics:

l VIPR SRM virtual appliance installation overview............................................... 10
l Installing the 4VM vApp.......................................................................................11
l Install additional ViPR SRM vApp VMs overview.................................................13
l Deploy Scaleout VMs in Existing vApp................................................................ 14
l Deploying Collector vApp VMs in different datacenters......................................16
l Post deployment, pre-startup tasks....................................................................17
l Adjusting the VMs.............................................................................................. 18
l Adding disk space............................................................................................... 18
l DataStores......................................................................................................... 18
l Modifying the start order of the vApps...............................................................19
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VIPR SRM virtual appliance installation overview
You can install ViPR SRM as a virtual appliance (vApp) in a supported VMware
environment. This guide describes the deployment process using the vSphere vCenter
Client. The ViPR SRM vApp can also be installed using the vSphere Web-based Client,
but the details are different and not included in this guide.

When you deploy the ViPR SRM vApp on a cluster of ESX servers, the vCenter DRS
function (Cluster features) must be enabled. If it is not enabled in your vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the ViPR SRM deployment, you can disable the DRS function.

The vApp is based on SuSE Enterprise SLES 11 SP4.

The MySQL version included with the product is 5.7.21 MySQL Community Server
(GPL).

Do not add any binary VMs into the vApp container (including any ViPR SRM binary
VMs).

The procedures enable you to install two types of software:

Core software

The core software is a reporting solution built on a scalable architecture of
backends, frontends, and distributed collectors. When you install the core
software, you establish the foundation for the product, which provides common
capabilities, functions, and user interfaces. In addition, the following separate
software products are pre-installed with ViPR SRM: ViPR SRM 4.2.1 SOFTWARE
IMAGE (453-010-807) and SLES 11 SP4 SW GPL3 OPEN SOURCE SOFTWARE
(453-010-808).

SolutionPacks

SolutionPacks are software components that support EMC and third-party
storage infrastructure components. Each SolutionPack enables you to select a
specific report in the UI. To learn more about the SolutionPacks that ViPR SRM
supports, see the following documents:

l EMC ViPR SRM Support Matrix

l EMC ViPR SRM Release Notes

l EMC ViPR SRM SolutionPack Guide

ViPR SRM vApps are distributed using Open Virtualization Format (OVF) files.
Depending on your environment's requirements, you will use the 4VM vApp OVF or the
1VM vApp OVF files.

4VM vApp OVF

Enables you to install four VMs (Frontend, Primary Backend, Additional Backend
and one Collector). A vApp VM will include an ADG directory that is used by the
autoconfiguration process of the vApp VMs. The 4VM vApp automatically
configures the Collector host to have 48 GB of memory and 8 CPUs. The
following SolutionPacks are pre-installed on the Collector host:

l Brocade FC Switch

l Cisco MDS/Nexus

l Isilon

l Physical Hosts

Installing the Virtual Appliance
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l Unity/VNX/VNXe

l VMAX/VMAX 2

l VMAX 3/VMAX All Flash

l VMware vCenter

l VPLEX

l XtremIO

1VM vApp OVF

Enables you to install a single vApp VM. The options are Frontend, Primary
Backend, Additional Backend, Collector and All-in-One. You can use this option to
install additional Collectors and Additional Backend VMs to scale out the existing
ViPR SRM installation. You can add a single vApp VM (Collector or Additional
Backend) to an existing vApp container that was created with the 4VM vApp.
When you restart the vApp container, the new VMs will be autoconfigured into
ViPR SRM. vApp VMs include an ADG directory that is used by the
autoconfiguration process. You can also use the 1VM vApp for small All-In-One
proof of concept solutions.

The Collector host deployed with the 1VM is configured with 16 GB of memory and 4
CPUs.

ViPR SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder needs to be moved from one vCenter
to another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method. For additional details, refer to Guidelines for
Managing VMware vApp Solutions (h15461).

ViPR SRM vApps fully support the VM vMotion and Storage vMotion DRS functions
of vCenter.

Installing the 4VM vApp
You can deploy the ViPR SRM 4VM appliance from an OVF template using a vCenter
Client. The installer creates the vApp container and deploys 4 vApp VMs (Frontend,
Primary Backend, Additional Backend, and one Collector) inside the vApp container.

Before you begin

l If you are installing ViPR SRM on a cluster of ESX Servers, VMware DRS
(Distributed Resource Scheduler) must be enabled.

l Gather the following information:

n vCenter location where you plan to deploy the appliance

n A single DataStore is needed for deployment. After completing the deployment,
you can use Storage vMotion to move the VM's storage to different
DataStores. The final storage size per VM will be provided by EMC.

n Static IP address for each VM. This IP address must be registered in DNS with
forward and reverse lookup before you begin the deployment.

n Gateway

n Netmask

n DNS servers

Installing the Virtual Appliance
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n Domain search strings. For a distributed ViPR SRM environment, the domains
for all the ViPR SRM servers must be entered for each of the ViPR SRM
servers.

Procedure

1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).

2. Click Downloads.

3. Download the ViPR SRM <version number> vApp Deployment zip file.

Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 4VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

4. Open vCenter Client and connect to the vCenter Server that manages your
VMware environment.

Do not run vCenter Client on a VPN connection.

For the fastest deployment time, the host running vCenter Client should be
local to the ESX servers.

5. Select where in the vCenter ESX cluster/server you want to deploy the VMs for
ViPR SRM.

6. Select File > Deploy OVF Template.

7. In the Source step, locate the 4VM OVF template file.

8. Click Next.

9. In the OVF Template Details step, review the details of the loaded OVF file,
and then click Next.

10. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.

11. In the Name and Location step:

a. Specify a new name or accept the default name for the appliance.

b. Specify an inventory location for the appliance in your VMware environment.

c. Click Next.

12. In the Resource Pool step, select the Resource Pool or the folder where the
deployment will place the ViPR SRM VMs, and click Next.

13. In the Storage step, select the destination storage (DataStore) for the virtual
machine files, and then click Next.

The compatibility window will state if there is insufficient disk space on the
selected DataStore, and a warning will display when you click Next.

14. In the Disk Format step, select the storage space provisioning method, and
then click Next.

Option Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.

Installing the Virtual Appliance
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Option Description

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

ViPR SRM is fully supported on thin-provisioned storage at the array or
virtualization level. Thin on thin is acceptable, but not recommended.

15. In the Network Mapping step, select a destination network for all of the VMs,
and then click Next.

With ViPR SRM 4.2, the only option is to place all 4 VMs on the same ESX
server network. This is known as the simplified network deployment.

16. In the IP Address Allocation step, choose the IP allocation policy and IP
protocol to use, and then click Next.

17. In the Properties step, provide the values for each of the VMs, and then click
Next.

18. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.

A pop-up window opens in vCenter Client showing the deployment progress.

19. After the 4VM deployment finishes, in the Deployment Completed
Successfully dialog box, click Close.

20. Before you power on the vApp, make the following changes to the VM
configurations:

l Add additional VMDK disks to expand the file system.

l Adjust the vCPU and VM Memory as specified in the ViPR SRM design

21. Use the 1VM OVF to add any Additional Backend VMs and Collector VMs as
described in the following section.

Install additional ViPR SRM vApp VMs overview
You can scale ViPR SRM larger by adding additional databases (Additional Backends),
Collectors, and slave Frontends. Use this procedure to deploy the additional VMs
needed to scale the ViPR SRM environment. This process includes adding Additional
Backend and Collector VMs to the existing ViPR SRM vApp container and deploying
Collector vApp VMs in different data centers.

For POC and lab installs an All-In-One solution is available. (The All-In-One solution is
not supported for managing production environments because it will not scale.)

When you deploy the ViPR SRM vApp on a cluster of ESX servers, the vCenter DRS
function (Cluster features) must be enabled. If it is not enabled in your vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the ViPR SRM deployment, you can disable the DRS function.

The vApp is based on SuSE Enterprise SLES 11 SP4.

The MySQL version included with the product is 5.7.21 MySQL Community Server
(GPL).

Do not add any binary VMs into the vApp container (including any ViPR SRM binary
VMs).
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The procedures enable you to install two types of software:

SolutionPacks

Software components that support EMC and third-party storage infrastructure
components. Each SolutionPack enables you to select a specific report in the UI.
To learn more about the SolutionPacks that ViPR SRM supports, see the
following documents:

l EMC ViPR SRM Support Matrix

l EMC ViPR SRM Release Notes

l EMC ViPR SRM SolutionPack Guide

ViPR SRM vApps are distributed using Open Virtualization Format (OVF) files. You will
use the 1VM vApp OVF files to scaleout Additional Backends, Collectors, and
Frontends.

1VM vApp OVF

Enables you to install a single vApp VM. The options are Frontend, Primary
Backend, Additional Backend, Collector and All-in-One. You can use this option to
install additional Collectors and Additional Backend VMs to scale out the existing
ViPR SRM installation. You can add a single vApp VM (Collector or Additional
Backend) to an existing vApp container that was created with the 4VM vApp.
When you restart the vApp container, the new VMs will be automatically
configured into ViPR SRM. vApp VMs include an ADG directory that is used by the
automatic configuration process.

ViPR SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder needs to be moved from one vCenter
to another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method.

ViPR SRM vApps fully support the VM vMotion and Storage vMotion DRS functions
of vCenter.

Deploy Scaleout VMs in Existing vApp
ViPR SRM supports adding additional backends and collectors either inside or outside
of the SRM vApp. Use this procedure to deploy scaleout VMs inside of the SRM vApp.

Before you begin

1. Login to the Virtual Center managing the vApp you want to scale out.

2. Right click the vApp and select Shut Down. Wait for all VMs in the vApp to shut
down completely.

Procedure

1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).

2. Click Downloads.

3. Download the ViPR SRM <version number> vApp Deployment zip file.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

4. Open the vSphere Client and connect to the vCenter Server that manages your
VMware environment.

Installing the Virtual Appliance
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5. Select the resource pool where you want to deploy the VMs for ViPR SRM.

6. Select File > Deploy OVF Template.

7. In the Source step, locate the 1VM OVF file.

8. Click Next.

To save time, deploy the appliance in the same local area network (LAN) that
your VMware ESX/ESXi servers share. Deployment takes approximately 5 to 15
minutes. Deployment across a WAN can take 2 hours or more.

9. In the OVF Template Details step, review the details of the loaded .ovf file
and click Next.

10. In the End User License Agreement step, review the license agreement, click
Accept, and then click Next.

11. In the Name and Location step, accept the default name (ViPR SRM) or type a
Name for the appliance. Specify an Inventory Location for the appliance in
your VMware environment. Click Next.

12. Select the host or cluster where you want to run the deployed template and
click Next.

13. Select the destination storage for the virtual machine files and click Next.

14. In the Disk Format step, select the storage space provisioning method and click
Next.

Option Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

EMC recommends the thin-provisioned format option when the vApp is
deployed in a high-performance environment.

15. In the Network Mapping step, select a destination network that has an IP Pool
associated with it for each of the VMs and click Next.

16. In the IP Address Allocation step, choose the IP allocation policy, the IP
protocol to use, and click Next.

17. In the Properties step, provide the values for each of the VMs, and click Next.

18. In the Ready to Complete step, review the list of properties for the appliance
and click Finish.

A status bar opens in the vSphere Client showing the deployment progress.

19. Click Close in the Deployment Completed Successfully dialog.

After you finish

1. Wait for all VMs to complete deployment.

2. Modify the start order of the vApp entities as described in Modify start order of
vApps.

3. Power on vApp after all deployments are completed. Right click the vApp and
select Power On.

Installing the Virtual Appliance
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A built-in service detects the new VMs and performs the needed configurations.

Deploying Collector vApp VMs in different datacenters
Use this procedure to deploy remote Collectors in different datacenters.

Procedure

1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).

2. Click Downloads.

3. Download the ViPR SRM <version number> vApp Deployment zip file.

Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

4. Open the vCenter Client and connect to the vCenter Server that manages your
VMware environment.

5. Select File > Deploy OVF Template.

6. In the Source step, locate the 1VM OVF file.

7. Click Next.

8. In the OVF Template Details step, review the details of the loaded .ovf file, and
click Next.

9. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.

10. In the Name and Location step:

a. Specify a new name or accept the default name for the appliance.

b. In the Inventory Location, select the Datacenter and sub-location where the
appliance will be deployed. Navigate through the folder levels to define the
exact location.

c. Click Next.

11. In the Deployment Configuration step, select the Collector Appliance from the
drop-down menu.

12. In the Host/Cluster step, select the ESX server or ESX Cluster, and click Next.

13. In the Resource Pool step, select the Resource Pool or the folder where the
deployment will place the ViPR SRM VMs, and click Next.

14. In the Storage step, select the DataStore for the virtual machine files, and then
click Next.

15. In the Disk Format step, select the storage space provisioning method, and
then click Next.

Option Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.
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Option Description

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

16. In the Network Mapping step, select a destination network for the VM, and
then click Next.

17. In the IP Address Allocation step, choose the Fixed IP allocation policy and the
IP protocol to use, and then click Next.

18. In the Properties step, provide the values for each field, and then click Next.

19. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.

A pop-up menu that shows the deployment progress opens in vCenter Client.

20. After the deployment finishes, in the Deployment Completed Successfully
dialog box, click Close.

21. Repeat these steps for each Collector that you need to install in a remote
datacenter.

22. Before you power on the vApp, make the following changes to the VM
configurations:

l Add additional VMDK disks to expand the file system.

l Adjust the vCPU and VM Memory as specified in the ViPR SRM design.

23. If you are adding a remote collector that is deployed in a remote datacenter to
the ViPR SRM vApp, use the steps for adding a collector that are described in 
Adding Remote Collectors to the existing ViPR SRM deployment. These steps
will finish the collector configuration and add the collector to the ViPR SRM UI.

After you finish

For Collectors installed in a remote datacenter, you will need to use the ViPR SRM UI
to make some configuration changes to the Load Balancer Connectors, generic-rsc,
and generic-snmp installed on each Collector.

Post deployment, pre-startup tasks
After you have deployed the vApp VMs, but before you start ViPR SRM, you must
make some configuration changes as specified in the ViPR SRM design provided by
EMC.

Procedure

1. Complete the following configuration changes:

l Adjust the Collector VM memory

l Adjust the Collector VM CPUs

l Change the vApp VM name in vCenter to conform to naming policies

l Increase the VM storage per VM

l Move the vApp VM storage to its assigned datastore

l Modify the vApp container startup order

Installing the Virtual Appliance
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Adjusting the VMs
The Collectors (and possibly the Frontend) will need the number of CPUs, the size,
and the memory adjusted based on the EMC ViPR SRM design. Edit the settings of
each Collector vApp VM to make these adjustments.

Procedure

1. The vApp VMs may need the default VM name changed to meet VM naming
standards. Edit the VM settings and select the Options tab to make these
changes.

Adding disk space
All vApp VMs are deployed with 132GB of storage. Each ViPR SRM VM will need larger
storage. The total ViPR SRM VM storage size is based on the EMC ViPR SRM design.
Edit the settings of each vApp VM and add a new VMDK (virtual machine disk).
Subtract 132GB from the total storage size specified in the sizing plan provided by
EMC, and add a new VMDK (virtual machine disk) with the size of the additional
storage needed. The VM can be running during this process.

Procedure

1. From the vCenter Console, select the individual VM where you want to add new
disk storage.

2. Select Edit Settings on the virtual machine and click Add.

3. Select Hard Disk and click Next.

4. Select Create a new virtual disk and click Next.

5. Specify the disk size, the provisioning type, the location of the disk and click
Next.

6. Specify the virtual device node (the default value should be OK) and click Next.

7. Review the options and click Finish.

8. After ViPR SRM is up and running, connect to the Linux host. You can access a
login prompt through the vCenter Client console or using an SSH tool such as
PuTTY.

9. At the root system prompt, type the command expand_disk.pl.

The script will merge the new VMDK with the existing files system while the VM
is still running. Use the df -h command when the script is finished to see the
new filesystem size.

DataStores
The 4VM vApp deployment places the 4 VMs on a single DataStore. Migrate the VM
from this DataStore to its assigned DataStore. The required storage per ViPR SRM
VM can be found in the design provided by EMC.

For reference, the target storage sizes are as follows:

l Frontend – 320 GB

l Primary Backend – 800 GB and larger

l Additional Backends – 1 TB and larger

Installing the Virtual Appliance
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l Collector – 300 GB or larger

With the VM in a powered off state, use the Storage vMotion feature to move the VM
to a new DataStore.

Modifying the start order of the vApps
Modify the start order of the vApps in a ViPR SRM installation whenever you add a
vApp VM to the vApp container.

Procedure

1. Right click the vApp and select Edit Settings.

2. Navigate to the Start Order tab.

3. Move the new VMs into the proper group based on the following:

l Group 1: All Additional Backends

l Group 2: Primary Backend

l Group 3: All Collectors

l Group 4: Frontend

4. In the Shutdown Action section, select Guest Shutdown from the Operation
list.

5. Change the elapsed time to 600 seconds.

6. Click OK.

Installing the Virtual Appliance
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CHAPTER 2

Using the ViPR SRM Setup Wizard

This chapter includes the following topics:

l Using the Discovery Wizard............................................................................... 22
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Using the Discovery Wizard
The Discovery Wizard is a tool to ease the initial deployment and configuration of the
most commonly used SolutionPacks. After upgrading to ViPR SRM 4.2 or later, you
may want to utilize the Discovery Wizard to quickly enable the SolutionPacks and add
the corresponding devices you would like to report on. In a few simple steps you can
now add your devices, monitor the collection process, and then jump to the reports to
see your data.

These steps use the VMAX 3/VMAX All Flash SolutionPack as an example.

Procedure

1. Log in to the user interface at https://<Frontend-hostname>:58080/
APG.

The default username is admin. The default password is changeme.

2. Access the Discovery Wizard at https://<Frontend-hostname>/
discovery-wizard/.

3. On the License page, you can add a permanent license by drag-and-dropping
the file onto the license box, or you can click the box and browse to the file.
Click Continue.

4. On the Storage Collection page, enter the FQDN or IP address of the
Unisphere for VMAX host. Enter the login credentials and port number. Click
Continue.

5. The Confirm Storage page lists the detected arrays. Select the arrays from
which you want to collect data. The meter at the bottom indicates how many
more volumes you can collect before you exceed the limit. When you are done
adding arrays, click Start Collection & Continue.

Note

The Confirm Storage page only applies to VMAX systems.

6. On the Fabric Collection page, select Brocade (SMI-S) or Cisco (SNMP)
from the drop-down menu. Enter the credentials and configuration options for
your switch. Click Start Collection & Continue.

Brocade SAN discovery with this wizard is through Brocade SMI-S only. This
solution provides limited switch performance and topology information with
WWNs. The Brocade SMI-S Data Collector deployed with the 4VM Collector is
configured to discover everything through SMI-S. When you deploy the
Brocade SolutionPack, the SMI-S Data Collector is configured to restrict the
data collection to zoning only. It is a best practice to discover the Brocade SAN
using SMIS-S for zoning and SNMP for everything else. This will provide
performance metrics and the topology will show friendly names.

7. On the Compute Collection page, enter the credentials for your VMware
vCenter Server. Click Start Collection and Continue.

8. The Collection Status page displays the status of the data collection and
provides links to next steps. Click Restart to repeat this process for each of
your device types.

9. Remove any pre-installed SolutionPacks and collectors that you do not plan to
use:

Using the ViPR SRM Setup Wizard

22 EMC ViPR SRM 4.2.1  Installation and Configuration Guide



a. Access the UI at https://<Frontend-hostname>/APG.

b. Enter the login credentials.

The default username is admin. The default password is changeme.

c. Navigate to Administration > Centralized Management > SolutionPacks.

d. Click the SolutionPack that you want to uninstall.

e. Click the Trashcan icon for each component.

f. Click Remove.

10. Refer to the ViPR SRM SolutionPack Guide for details about installing
SolutionPacks that were not pre-installed.

Using the ViPR SRM Setup Wizard
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CHAPTER 3

Working with ViPR SRM

This chapter includes the following topics:

l Starting the vApp...............................................................................................26
l VIPR SRM Passwords........................................................................................ 26
l Verifying that the services are running...............................................................27
l Logging in to the user interface..........................................................................27
l Reconfiguring the LBC, Generic-SNMP, and Generic-RSC................................28
l Verifying MySQL DB Grants...............................................................................28
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Starting the vApp
The ViPR SRM startup order is controlled by the vApp container settings

Before you begin

Edit the start-up as described in Post deployment, pre-startup tasks.

Always start and stop the vApp using the vApp container. Do not stop any of the
individual VMs inside the vApp container. You can start and stop Remote Collectors in
other datacenters independently. Use vCenter Client to start the vApp.

The initial startup of ViPR SRM will not be ready for login for about 10 minutes after
the VMs are shown as started in vCenter because an internal configuration process to
configure each VM must complete. You can monitor this process by opening the
vCenter Console for the VM.

Procedure

1. ViPR SRM will be ready for login after the additional background processing
completes. The URL for logging in is https://<Frontend-hostname>:
58443/APG

VIPR SRM Passwords
Passwords control access to ViPR SRM and the internal communications.

The web-based user passwords are managed through the Administration user
interface. The ViPR SRM internal communications passwords are managed through
the Centralized Management > Central Configuration Repository. For additional
details, refer to Security Configuration Guide.

Table 1 Default usernames and passwords

Environment Default username and password

Web-based console accessed in a browser admin/changeme Ensure that you change

this password.

ws-user watch4net

MySQL watch4net

apg user watch4net

MySQL root user watch4net

Linux guest OS appliance console accessed
through SSH or vCenter

root/Changeme1!

If you choose to change the root user password, the password must conform to the
following requirements:

l Be at least eight characters and no more than 40 characters

l Contain at least one numeric character

l Contain at least one uppercase and one lowercase character

l Contain at least one non-alphanumeric character such as # or !

l Cannot contain the single quote character (') because it is a delimiter for the
password string
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Note

The web-based requirements do not apply to Linux passwords.

Verifying that the services are running
Verify that the services are running on each host by obtaining the status.

Before you begin

Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
Procedure

1. Type the command for your operating system from the bin directory of the
installation:

Operating system Command

UNIX manage-modules.sh service status all
Windows manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.

Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with root to check the log files.

Procedure

l The default path is /opt/APG/.

The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).

Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log

Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet your needs

Procedure

1. Open a browser and type the following URL:

https://<Frontend-hostname>:58443/APG
2. Type the login credentials.

The default username is admin. The default password is changeme.
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3. Click Sign In.

Note

You are automatically logged off after four hours.

Reconfiguring the LBC, Generic-SNMP, and Generic-RSC
If a collector is powered on outside of the vApp, you must reconfigure the Load
Balancer Connector, generic-snmp, and generic-rsc.

Procedure

1. From Centralized Management, click SolutionPacks.

2. Under Other Components, click the Reconfigure icon for a Load Balancer
Connector for each remote Collector. Use the following settings:

l Arbiter Configuration: send data to the Primary Backend over port 2020.

l Alerting on data collection: send data to the Primary Backend over port
2010.

l Frontend Web service: send data to the Frontend over port 58080.

3. Repeat these steps for each remote Collector's Load Balancer Connector.

4. Under Other Components, click the Reconfigure icon for a generic-snmp or
generic-rsc instance. Use the following settings:

l Data Configuration: send data to the localhost over port 2020.

l Frontend Web service: send data to the Frontend over port 58080.

l Topology Service: send data to the Primary backend.

5. In the SNMP Collector Name field, enter the FQDN of the collector host.

6. Repeat the steps for each instance of generic-snmp and generic-rsc.

Verifying MySQL DB Grants
After installing and configuring the ViPR SRM hosts, you can cross check the grant
privileges configured for the ViPR SRM servers that are listed in the SRM-Conf-Tools
configuration file.

Database grants for Collector hosts are not required.

Where the scripts configure grants for Collector hosts, these are not needed and can
be ignored or deleted.

Procedure

1. Run the following script:

/opt/APG/bin/mysql-client.sh 

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.
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3. Run the following query:

mysql> SELECT user, host, db, select_priv, insert_priv, 
grant_priv FROM mysql.db;

The following table is an example of the configuration you should see on an Additional
Backend host:

Working with ViPR SRM
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CHAPTER 4

ViPR SRM Configuration Tools

This chapter includes the following topics:

l ViPR SRM configuration tools............................................................................32
l Creating the SRM-Conf-Tools answers file........................................................32
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ViPR SRM configuration tools
ViPR SRM Configuration Tools (SRM-Conf-Tools) is installed with the ViPR SRM
software in the /opt/APG/bin directory. These tools work with both vApp and
binary deployments.

The SRM-Conf-Tools scripts use an answers file to automatically configure the ViPR
SRM servers. You can use the SRM-Conf-Tools for the following scenarios:

l Initial configuration of a Frontend, Primary Backend, and Additional Backend
servers

l Adding new Additional Backend servers to an existing ViPR SRM environment

l Adding new Collectors to an existing ViPR SRM environment

Before you begin, deploy all of the Collectors in all of the remote datacenters. They
can be Collector vApps, or binary Linux or Windows Collectors.

Binary Collectors are installed using the "Collector" install option for both Linux and
Windows. A Collector configuration script in SRM-Conf-Tools finishes the Collector
configuration so that it is the same as a vApp collector.

If an SRM-Conf-Tools script configuration fails, you cannot run the script a second
time. If the configuration fails, you must clean ViPR SRM from the server and reinstall
ViPR SRM. Refer to Uninstallation.

If you are using vCenter Snaphots, power down the VM and take a snapshot before
running the scale-tools script.

Creating the SRM-Conf-Tools answers file
SRM-Conf-Tools is a command-line utility that can configure and add a single server
or multiple servers to your ViPR SRM environement. SRM-Conf-Tools uses an
answers file that you create that includes all of the ViPR SRM hosts in all of the
datacenters where ViPR SRM is installed.

Before you begin

l The answers file is case sensitive and must be all lowercase.

l Create the file using notepad++ or the Linux vi editor.

l Name the file srm-hosts.

The format of the answers file is: server_type=hostname:os
Definition Description

server_type The four basic types of ViPR SRM servers

hostname The server's FQDN. It matches the setting of
the hostname variable in the
apg.properties file. For Linux servers, this

should always be the hostname plus the
domain name (FQDN). For Windows, this
could be the hostname (shortname) or the
FQDN depending on how the Windows server
resolution is configured (DNS, Active DNS, or
Wins/NetBios). A Wins resolution will use the
hostname (shortname) in uppercase.
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Definition Description

OS linux-x64 or windows-x64

For example:

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64

This answers file can be modified later to add any new Collectors and Additional
Backends. When the SRM-Conf-Tools scripts run, they distinguish new servers from
existing servers and make the necessary configuration changes.

Because the SRM-Conf-Tools and the answers file can be used for configuring
additional servers at a later date, EMC recommends storing the files in a /sw directory
in the / directory instead of the /tmp directory because the /tmp directory could be
deleted at any time.
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CHAPTER 5

Configuring Remote Collectors

This chapter includes the following topics:

l Adding remote Collectors to the existing ViPR SRM deployment.......................36
l Reconfiguring the LBC, Generic-SNMP, and Generic-RSC................................36

Configuring Remote Collectors     35



Adding remote Collectors to the existing ViPR SRM
deployment.

When you add a vApp Collector VM, it is completely configured as a Collector host
with all of the components. You can add the Collector through Centralized
Management > Configuration > Server > Register a Server. If you have multiple
remote vApp collectors, you can use the launch-frontend-scale-
collector.sh -c /sw/srm-hosts script to register the Collectors. For details
about using the SRM-Config-Tool, see ViPR SRM configuration tools.

Database grants for Collector hosts are not required.

Use the following procedure to add a binary Collector.

Note

For Windows, use .cmd instead of .sh, and / instead of \ for directories.

Procedure

1. Install the ViPR SRM software as described in Installing on UNIX or Installing on
Windows Server.

2. Configure the binary collectors:

a. Navigate to the following directory:

Linux: cd /opt/APG/bin
Windows: cd Program Files/APG/bin

b. Run the Collector configuration script:

launch-collector-configuration.sh –c /sw/srm-hosts

c. Verify that all of the services are running:

manage-modules.sh service status all

3. On the Frontend, run the following command:

launch-frontend-scale-collector.sh -c /sw/srm-hosts

4. Verify the Remote Collector configuration through the ViPR SRM UI.

Reconfiguring the LBC, Generic-SNMP, and Generic-RSC
If a collector is powered on outside of the vApp, you must reconfigure the Load
Balancer Connector, generic-snmp, and generic-rsc.

Procedure

1. From Centralized Management, click SolutionPacks.
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2. Under Other Components, click the Reconfigure icon for a Load Balancer
Connector for each remote Collector. Use the following settings:

l Arbiter Configuration: send data to the Primary Backend over port 2020.

l Alerting on data collection: send data to the Primary Backend over port
2010.

l Frontend Web service: send data to the Frontend over port 58080.

3. Repeat these steps for each remote Collector's Load Balancer Connector.

4. Under Other Components, click the Reconfigure icon for a generic-snmp or
generic-rsc instance. Use the following settings:

l Data Configuration: send data to the localhost over port 2020.

l Frontend Web service: send data to the Frontend over port 58080.

l Topology Service: send data to the Primary backend.

5. In the SNMP Collector Name field, enter the FQDN of the collector host.

6. Repeat the steps for each instance of generic-snmp and generic-rsc.
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CHAPTER 6

Installing Using the Binary Installer

This chapter includes the following topics:

l Installation options for a standard installation.................................................... 40
l General ViPR SRM requirements....................................................................... 40
l Linux requirements............................................................................................. 41
l Installing on Linux............................................................................................... 41
l Installing on Windows Server............................................................................. 43
l Configuring binary ViPR SRM SRM-Conf-Tools.................................................44
l Installing and configuring the Primary Backend host..........................................45
l Installing and configuring the Additional Backend hosts..................................... 46
l Installing and configuring the Collector host...................................................... 47
l Installing and configuring the Frontend host...................................................... 47
l Scaling-out a ViPR SRM environment with Additional Backend hosts................49
l Scaling-out a ViPR SRM environment with Collector hosts................................ 51
l Verifying MySQL DB Grants...............................................................................52
l Updating firewall ports in Red Hat and CentOS servers..................................... 53
l Editing new actions scripts................................................................................ 55
l Verifying that the services are running...............................................................55
l Logging in to the user interface......................................................................... 56
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Installation options for a standard installation
Learn how to install the platform using a binary installation package.

The platform infrastructure consists of four types of hosts:

l Frontend host

l Backend hosts (Primary Backend and Additional Backend)

l Collector host

l All-In-One (recommended for POCs and testing only)

You can only have one Primary Backend host. You can add Additional Backend hosts
with up to four Time-Series databases on each Additional Backend host.

For ViPR SRM deployments with 5 million metrics or more, EMC recommends that the
core ViPR SRM hosts (Frontend, Primary Backend and Additional Backend hosts) use
the Linux operating system.

The MySQL version included with the product is 5.7.21 MySQL Community Server
(GPL).

Table 2 Installation Options

Installation
Options

Frontend Primary
Backend

Additional
Backend

Collector

Linux Installation
Options

[f]rontend [b]ackend [m]inimal [c]ollector

Windows
Installation
Options

Frontend
Modules

Backend
Modules

Base Installation
(with none of the
modules
selected)

Collector
Modules

General ViPR SRM requirements
These requirements are for a minimal deployment. In a production environment, the
requirements will vary depending on the provisioned load, and you must include careful
planning and sizing before beginning the deployment.

The ViPR SRM Workbench and the EMC ViPR SRM Performance and Scalability
Guidelines document associated with your specific release will provide guidance for
SolutionPacks and object discovery.

For details about configuring CA SSL certificates, refer to the EMC M&R Security
Configuration Guide.

The environment must meet the following requirements:

l 64 bit operating system (Linux or Windows)

l Frontend – 16 GB RAM, 4 CPUs, and 320 GB disk storage

l Backends – 24 GB RAM, 4 CPUs, and disk storage determined by the sizing

l Collectors – 16 to 64 GB RAM, 4 to 8 CPUs, and 130+ GB disk storage

l Forward and Reverse IP and DNS lookups must work on each server
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Note

The following sections use Linux commands and directories as examples. For
Windows, use .cmd instead of .sh, and / instead of \ for directories.

Linux requirements
The environment must meet the following requirements. Make adjustments to the
host before continuing.

l /tmp folder larger than 2.5 GB

l SWAP file should be at least equal to the RAM size

l On CentOs or RedHat-like Linux, the SELinux should be disabled or reconfigured

l The graphical desktop environment is not required

l On some Linux distributions:

n MySQL server requires libaio1, libaio-dev, or libaio to start

n The installation process requires unzip

n On system restart the apg services may not start

Installing on Linux
You can install the product on supported UNIXLinux hosts. This procedure specifically
uses the Linux installation procedure as an example.

Before you begin

l Ensure that you have a login with root privileges. This product should only be
installed using root and root privileges.

l Ensure that the ports listed in the Ports Usage Matrix are enabled and not blocked
by a host or network firewall.
Refer to Updating firewall ports in Red Hat and CentOS servers.

l Download the installation file from support.emc.com, and place it in a folder
(for example /sw) on the server.

l MySQL DB is upgraded to 5.7.21 in SRM 4.2.1. MySQL 5.7.21 requires Libnuma
library to be installed on the system for binary installs on Linux platform. Without
this library, Install and Upgrade to 4.2.1 will fail. This library is included in vApp.
vApp installation/Upgrade will not have this issue.

These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.

Procedure

1. Log in to the server as root.

2. Navigate to the /sw folder.

3. Change the permissions of the installer.

For example: chmod +x <file_name>.sh
4. Run the installer from the directory.

For example: ./<file_name>.sh
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5. Read and accept the End User License Agreement.

6. Accept the default installation directory of /opt/APG or type another location.

7. Select the appropriate installation option for the type of host that you are
installing. Refer to Installation Options for details.

Configuring the user process limits for a Linux installation
Increase the user process limits for the apg user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.
This step is required for proper functioning of the core software.

Before you begin

l Make sure you have a login with root privileges.

l The core software installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6, SUSE Linux Enterprise Server (SLES) 11, or any other supported
Linux operating systems.

Procedure

1. Edit the security file: vi /etc/security/limits.conf.

2. Insert the following lines for the apg user below the line with #<domain>.

In this example, the user is apg.

apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534

3. Save the file.

4. To verify the changes, type the following command:

su apg -c 'ulimit -n -u'
open files                                  (-n)    65534
max user processes         (-n) 65534

5. In the /opt/APG/bin/apg.properties file, edit the hostname to a FQDN
host name:

#===================
# Common Properties
#===================
hostname=lglba148.lss.emc.com

6. To restart the services, type the following commands from the /opt/APG/bin
directory of the installation:

/opt/APG/bin/manage-modules.sh service stop all
/opt/APG/bin/manage-modules.sh service start all
/opt/APG/bin/manage-modules.sh service status all
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Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.

After installing MySQL Server, it is recommended that you disable virus scanning on
the directory used to store your MySQL table data (such as /opt/APG/Databases/
MySQL/Default/data). In addition, by default, MySQL creates temporary files in
the standard temporary directory. To prevent scanning the temporary files, configure
a separate temporary directory for MySQL temporary files and add this directory to
the virus scanning exclusion list. To do this, add a configuration option for the tmpdir
parameter to your my.ini configuration file.

Installing on Windows Server
You can install the product on supported Windows Server hosts.

Before you begin

l Ensure that the \tmp folder is larger than 2.5 GB.

l Ensure that you have a login with system administrator privileges.

l Ensure that the ports listed in the Ports Usage Matrix are enabled and not blocked
by the firewall.

l Download the installation file from support.emc.com, and place it in a folder
(for example, c:\sw) on the server.

These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.

Procedure

1. Navigate to the c:\sw folder.

2. Double-click the .exe file.

3. Click Next on the Welcome screen.

4. Read and accept the End User License Agreement. Click I Agree.

5. Select the Destination Folder, and then click Next.

6. Select the appropriate installation option for the type of host that you are
installing. Refer to Installation Options for details.

7. Click Install.

8. When the installation is complete, click Next.

9. Click Finish.

10. In the Program Files\APG\bin\apg.properties file, verify that the
hostname is a FQDN host name. If the hostname is a shortname, edit the file to
change the hostname to a FQDN.

11. STOP: Repeat the ViPR SRM installation and configuration process for all of
the servers in this deployment before proceeding.

12. In the c:\windows\System32\drivers\etc\hosts file, verify that the
first uncommented line is this host's IP-address, FQDN, and shortname. If this is
not first uncommented line, edit the file.
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13. Restart the services, and troubleshoot any service that does not show a status
of “running.”

manage-modules.cmd service restart all
manage-modules.cmd service status all

Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.

After installing MySQL Server, it is recommended that you disable virus scanning on
the directory used to store your MySQL table data (such as C:\Program Files
\APG\Databases\MySQL\Default\data). In addition, by default, MySQL creates
temporary files in the standard Windows temporary directory. To prevent scanning the
temporary files, configure a separate temporary directory for MySQL temporary files
and add this directory to the virus scanning exclusion list. To do this, add a
configuration option for the tmpdir parameter to your my.ini configuration file.

Configuring binary ViPR SRM SRM-Conf-Tools
SRM-Conf-Tools are scripts that are pre-installed on each SRM host in
the /opt/APG/bin directory. These scripts are used to configure the ViPR SRM
hosts the same way the vApp version is configured.

The SRM-Conf-Tools scripts use an answers file to automatically configure the ViPR
SRM servers. You can use the SRM-Conf-Tools scripts for the following scenarios:

l Initial configuration of a Frontend, Primary Backend, and Additional Backend
servers

l Adding new Additional Backend servers to an existing ViPR SRM environment

l Adding Collectors to the Frontend.

If a SRM-Conf-Tools script configuration fails, running it again could cause a miss-
configuration. It is advisable to clean ViPR SRM from that VM/Server and reinstall the
product. Refer to Uninstallation.

Creating the SRM-Conf-Tools answers file
SRM-Conf-Tools is a command-line utility that can configure and add a single server
or multiple servers to your ViPR SRM environement. SRM-Conf-Tools uses an
answers file that you create that includes all of the ViPR SRM hosts in all of the
datacenters where ViPR SRM is installed.

Before you begin

l The answers file is case sensitive and must be all lowercase.

l Create the file using notepad++ or the Linux vi editor.

l Name the file srm-hosts.

The format of the answers file is: server_type=hostname:os
Definition Description

server_type The four basic types of ViPR SRM servers
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Definition Description

hostname The server's FQDN. It matches the setting of
the hostname variable in the
apg.properties file. For Linux servers, this

should always be the hostname plus the
domain name (FQDN). For Windows, this
could be the hostname (shortname) or the
FQDN depending on how the Windows server
resolution is configured (DNS, Active DNS, or
Wins/NetBios). A Wins resolution will use the
hostname (shortname) in uppercase.

OS linux-x64 or windows-x64

For example:

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64

This answers file can be modified later to add any new Collectors and Additional
Backends. When the SRM-Conf-Tools scripts run, they distinguish new servers from
existing servers and make the necessary configuration changes.

Because the SRM-Conf-Tools and the answers file can be used for configuring
additional servers at a later date, EMC recommends storing the files in a /sw directory
in the / directory instead of the /tmp directory because the /tmp directory could be
deleted at any time.

Installing and configuring the Primary Backend host

Before you begin

l Identify the host you want to configure as the Primary Backend host.

l Identify the hosts you want to configure as the Frontend, Collectors, and
Additional Backends.

l Ensure that you have created an answers file as described in Creating the SRM-
Conf-Tools answers file.

l Minimum System Requirements:

n CPU: 4

n Memory: 24 GB (refer to your ViPR SRM design document)

n Disk Space: 132 GB (the final storage size per server will be adjusted later)

Procedure

1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX.

2. Navigate to /opt/APG/bin.

3. Run the Primary Backend configuration script:

./launch-primarybackend-configuration.sh –c /sw/srm-hosts
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4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Check the DB grants as described in Verifying DB grants. (Collectors do not
need DB grants.)

Installing and configuring the Additional Backend hosts

Before you begin

l Identify the host you want to configure as the Additional Backend host.

l Identify the hosts you want to configure as the Frontend, Collectors, Primary
Backends, and Additional Backends.

l Ensure that you have created an answers file as described in Creating the SRM-
Conf-Tools answers file.

l Minimum System Requirements:

n 64-bit Operating System

n CPU: 4

n Memory: 24 GB

n Disk Space: 132 GB (the final storage size per server will be adjusted later)

Procedure

1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on Linux.

2. Navigate to /opt/APG/bin.

3. Run the Additional Backend configuration script:

./launch-additionalbackend-configuration.sh –c /sw/srm-hosts

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Check the DB grants as described in Verifying DB grants. (Collectors do not
need DB grants.)
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Installing and configuring the Collector host

Before you begin

l Identify the hosts you want to configure as the Collector hosts.

l Ensure that you have created an answers file as described in Creating the SRM-
Conf-Tools answers file.

l Collector to Mega Collector System Requirements:

n 64 bit operating system (Linux or Windows)

n CPU: 4 to 8

n Memory: 16 GB to 64 GB (refer to your ViPR SRM design document)

n Disk Space: 132 GB (the final storage size per server will be adjusted later)

Procedure

1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX and/or Installing on Windows
Server.

2. Navigate to .../APG/bin.

3. Run the Collector configuration script:

./launch-collector-configuration.sh –c /sw/srm-hosts

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. The Generic-RSC and Generic-SNMP modules will be installed by default. If you
do not plan to use this collector for host discovery or SNMP discovery, you can
choose to remove these modules. To remove these modules:

/.../APG/bin/manage-modules.sh remove generic-snmp

Installing and configuring the Frontend host

Before you begin

l Ensure that the configuration for the Primary Backend host is complete before
starting the Frontend configuration.

l Ensure that you have the details of the Frontend host.

l Ensure that you have created an answers file as described in Creating the SRM-
Conf-Tools answers file.
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l Minimum System Requirements:

n 64-bit Operating System

n CPU: 4

n Memory: 16 GB

n Disk Space: 132 GB (the final storage size per server will be adjusted later)

Procedure

1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on Linux.

2. Navigate to /opt/APG/bin.

3. Run the Frontend configuration script:

./launch-frontend-configuration.sh –c /sw/srm-hosts

During the Frontend configuration the management-resources are configured
on the Primary Backend server. If the ViPR SRM ports are not open, then this
configuration script will fail with this error: "Some operations failed to execute
successfully." Review the logs and fix any errors manually. Refer to Adding Red
Hat and CentOS server firewall ports to establish the ViPR SRM ports on all the
ViPR SRM servers. Do not attempt to run this script again. You must remove
ViPR SRM from the server where you were running the script and reinstall ViPR
SRM. Refer to Uninstallation.

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Verify that the ViPR SRM management resources have been created:

 /opt/APG/bin/manage-resources.sh list

The following output shows the management resources based on the example
configuration used in the document:

"dba/APG-DB",
  "dba/APG-DB-lglac142-1",
  "dba/APG-DB-lglac142-2",
  "dba/APG-DB-lglac142-3",
  "dba/APG-DB-lglac142-4",
  "dba/FLOW-COMPLIANCE-BREACH",
  "dba/FLOW-COMPLIANCE-CONFIGCHANGE",
  "dba/FLOW-COMPLIANCE-POLICY",
  "dba/FLOW-COMPLIANCE-RULE",
  "dba/FLOW-EVENTS-GENERIC",
  "dba/FLOW-EVENTS-GENERICARCH",
  "dba/FLOW-OUTAGE-DB",
  "dba/FLOW-PROSPHERE-ARCH",
  "dba/FLOW-PROSPHERE-LIVE",
  "dba/FLOW-RPE2-ARCH",
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  "dba/FLOW-RPE2-LIVE",
  "dba/FLOW-SOM-ARCH",
  "dba/FLOW-SOM-LIVE",
  "dba/FLOW-UCS-LIVE",
  "dba/FLOW-VIPR-EVENTS",
  "dba/FLOW-VMWARE-EVENTS",
  "dba/FLOW-VMWARE-TASKS",
  "dba/FLOW-VNX-LIVE",
  "dba/FLOW-WHATIF-SCENARIOS",
  "mgmt/APG-DB",
  "mgmt/APG-DB-lglac142-1",
  "mgmt/APG-DB-lglac142-2",
  "mgmt/APG-DB-lglac142-3",
  "mgmt/APG-DB-lglac142-4",
  "rest/EVENTS",
  "rest/METRICS"

Results

At this point, the basic ViPR SRM configuration is complete and you can log in to the
UI. Navigate to Centralized Management > Physical Overview to see the four
servers that you just configured.

Scaling-out a ViPR SRM environment with Additional
Backend hosts

This process completes the configurations for adding the Additional Backend to the
existing ViPR SRM environment using the SRM-Conf-Tools. Additional Backend hosts
should always be on a Linux OS platform.

Before you begin

l Complete the steps described in Installing on Linux.

l Identify the host you want to configure as the Additional Backend host.

l Get the details of the existing ViPR SRM environment that you want to scale.

l Minimum System Requirements:

n 64-bit Operating System

n CPU: 4

n Memory: 24 GB

n Disk Space: 132 GB (the final storage size per server will be adjusted later)

Procedure

1. Navigate to /opt/APG/bin.

2. Modify the SRM-Conf-Tools answer file (srm-hosts) as described in Creating
the SRM-Conf-Tools answers file .

3. Add the new Additional Backend to the original srm-hosts file in the /sw
directory.

In the example below, additionalbackend_2 is the new Additional Backend.

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
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additionalbackend_2=lglac143.lss.emc.com:linux-x64
collector_1=lppd149.lss.emc.com:linux-x64

4. Copy the modified answer file (srm-hosts) to these ViPR SRM Frontend,
Primary Backend, and Additional Backends. (The modified file is not needed on
the existing Collector servers.)

5. Navigate to /opt/APG/bin.

6. Run the following script to configure the new Additional Backend host:

launch-additionalbackend-configuration.sh –c /sw/srm-hosts

7. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

8. Run the following script on all existing Additional Backend hosts:

./launch-additionalbackend-scale-additionalbackend.sh –c / sw/
srm-hosts

9. Run the following script on the Primary Backend host:

./launch-primarybackend-scale-additionalbackend.sh –c / sw/
srm-hosts

10. Run the following script on the Master Frontend host:

./launch-frontend-scale-additionalbackend.sh –c / sw/srm-hosts

11. List the Management Resources to verify that the Additional Backends hosts
were added:

./manage-resources.sh list

In this example configuration, the following entries would be added to the list of
resources:

"dba/APG-DB-lglba250-1",
  "dba/APG-DB-lglba250-2",
  "dba/APG-DB-lglba250-3",
  "dba/APG-DB-lglba250-4",

  "mgmt/APG-DB-lglba250-1",
  "mgmt/APG-DB-lglba250-2",
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  "mgmt/APG-DB-lglba250-3",
  "mgmt/APG-DB-lglba250-4",

12. Restart all of the services on the Additional Backend servers, Primary Backend
server, and Frontend Server.

13. Log in to ViPR SRM and confirm that the new Additional Backend is in the UI.

Results

The Additional Backend hosts are added to the existing ViPR SRM configuration.
Navigate to Centralized Management > Physical Overview to see the five servers
that you have configured.

Scaling-out a ViPR SRM environment with Collector hosts
This process completes the configurations for adding Collector hosts to the existing
ViPR SRM environment using the SRM-Conf-Tools. Collector software can be
installed on a Linux or Windows platform. (Currently the Hyper-V SolutionPack
requires a Windows platform.)

Before you begin

l Complete the steps described in Installing on Linux and/or Installing on Windows.

l Identify the host you want to configure as the Collector host.

l Get the details of the existing ViPR SRM environment that you want to scale.

l Minimum System Requirements:

n 64-bit Operating System

n CPU: 4 to 8

n Memory: 16 to 64 GB (refer to your ViPR SRM design document)

n Disk Space: 120 GB (the final storage size per server will be adjusted later)

Note

For Windows, convert .sh to .cmd for the commands and / to \ for directories.

Procedure

1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX or Installing on Windows Server.

2. Navigate to .../APG/bin.

3. Modify the SRM-Conf-Tools answer file (srm-hosts) as described in Creating
the SRM-Conf-Tools answers file.

4. Add the new collector to the srm-hosts file.

In the example below, collector_2 is the new Collector.

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
additionalbackend_2=lglac143.lss.emc.com:linux-x64
collector_1=lppd149.lss.emc.com:linux-x64
collector_2=lglba150.lss.emc.com:linux-x64
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5. Copy the modified answer file (srm-hosts) to the ViPR SRM Frontend, (This
new file is not needed on the existing ViPR SRM servers.)

6. Navigate to .../APG/bin.

7. Run the following script to configure the new Collector host:

./launch-collector-configuration.sh –c /sw/srm-hosts

8. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

9. Run the following script on each Frontend:

./launch-frontend-scale-collector.sh –c / sw/srm-hosts

Results

The Collector hosts are added to the existing ViPR SRM configuration. Navigate to
Centralized Management > Physical Overview to see the six servers that you have
configured.

Verifying MySQL DB Grants
After installing and configuring the ViPR SRM hosts, you can cross check the grant
privileges configured for the ViPR SRM servers that are listed in the SRM-Conf-Tools
configuration file.

Database grants for Collector hosts are not required.

Where the scripts configure grants for Collector hosts, these are not needed and can
be ignored or deleted.

Procedure

1. Run the following script:

/opt/APG/bin/mysql-client.sh 

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.

3. Run the following query:

mysql> SELECT user, host, db, select_priv, insert_priv, 
grant_priv FROM mysql.db;
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The following table is an example of the configuration you should see on an Additional
Backend host:

Updating firewall ports in Red Hat and CentOS servers
The Red Hat and CentOS operating systems are installed by default with the OS
firewall (firewalld) locked down. Only a few basic ports are open (such as SSH). On
these operating systems, the firewall must be modified to allow the ViPR SRM ports.

Procedure

1. Using a Linux editor, create an xml file and save it as apg.xml in the /etc/
firewalld/services directory.

2. Add the following text to the xml file:

<?xml version="1.0" encoding="utf-8"?>
<service>
  <short>TEST</short>
  <description>Add ViPR SRM Ports to Red Hat and CentOS 
Firewall</description>
  <port protocol="tcp" port="58080"/>
  <port protocol="tcp" port="2000"/>
  <port protocol="tcp" port="2001"/>
  <port protocol="tcp" port="2100"/>
  <port protocol="tcp" port="2101"/>
  <port protocol="tcp" port="2200"/>
  <port protocol="tcp" port="2201"/>
  <port protocol="tcp" port="2300"/>
  <port protocol="tcp" port="2301"/>
  <port protocol="tcp" port="2400"/>
  <port protocol="tcp" port="2401"/>
  <port protocol="tcp" port="2003"/>
  <port protocol="tcp" port="2008"/>
  <port protocol="tcp" port="2009"/>
  <port protocol="tcp" port="2010"/>
  <port protocol="tcp" port="2012"/>
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  <port protocol="tcp" port="2020"/>
  <port protocol="tcp" port="2022"/>
  <port protocol="tcp" port="2040"/>
  <port protocol="tcp" port="2041"/>
  <port protocol="tcp" port="5480"/>
  <port protocol="tcp" port="5488"/>
  <port protocol="tcp" port="5489"/>
  <port protocol="tcp" port="8082"/>
  <port protocol="tcp" port="8189"/>
  <port protocol="tcp" port="8888"/>
  <port protocol="tcp" port="8889"/>
  <port protocol="tcp" port="9996"/>
  <port protocol="tcp" port="22000"/>
  <port protocol="tcp" port="22020"/>
  <port protocol="tcp" port="22020"/>
  <port protocol="tcp" port="48443"/>
  <port protocol="tcp" port="52001"/>
  <port protocol="tcp" port="52004"/>
  <port protocol="tcp" port="52007"/>
  <port protocol="tcp" port="52569"/>
  <port protocol="tcp" port="52755"/>
  <port protocol="tcp" port="53306"/>
  <port protocol="tcp" port="58005"/>
  <port protocol="tcp" port="389"/>
  <port protocol="tcp" port="58443"/>
  <port protocol="tcp" port="5988"/>
  <port protocol="tcp" port="5989"/>
  <port protocol="tcp" port="5986"/>
  <port protocol="tcp" port="80"/>
  <port protocol="tcp" port="443"/>
  <port protocol="tcp" port="8080"/>
  <port protocol="tcp" port="2707"/>
  <port protocol="tcp" port="8443"/>
  <port protocol="tcp" port="2443"/>
  <port protocol="tcp" port="4443"/>
  <port protocol="tcp" port="2682"/>
  <port protocol="tcp" port="1521"/>
  <port protocol="tcp" port="9004"/>
  <port protocol="tcp" port="9002"/>
  <port protocol="tcp" port="7225"/>
  <port protocol="tcp" port="58083"/>
  <port protocol="tcp" port="52755"/>
  <port protocol="tcp" port="2060"/>
  <port protocol="tcp" port="3682"/>
  <port protocol="udp" port="161"/>
  <port protocol="udp" port="162"/>
  <port protocol="udp" port="2040"/>
  <port protocol="udp" port="2041"/>
</service>

3. Copy the apg.xml file to the /etc/firewalld/services directory.

4. Run the following command to add the ports to the existing firewall:

firewall-cmd --permanent --add-service=apg

5. Check the status of firewalld:

systemctl status firewalld

Installing Using the Binary Installer

54 EMC ViPR SRM 4.2.1  Installation and Configuration Guide



Editing new actions scripts
Edit actions on the frontend host to send events to the machine on which the event-
processing-manager of the alerting-consolidation module is configured.

Procedure

1. In the following file, replace 127.0.0.1 with the primary backend IP address or
FQDN:

Option Description

Linux /opt/APG/Custom/WebApps-Resources/Default/
actions/event-mgmt/linux/conf

Windows Program Files\APG\Custom\WebApps-Resources
\Default\actions\event-mgmt\windows\conf.cmd

Verifying that the services are running
Verify that the services are running on each host by obtaining the status.

Before you begin

Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
Procedure

1. Type the command for your operating system from the bin directory of the
installation:

Operating system Command

UNIX manage-modules.sh service status all
Windows manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.

Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with root to check the log files.

Procedure

l The default path is /opt/APG/.

The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).

Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
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Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log

Troubleshooting service start-up problems on Windows
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with system administrator credentials to check the log
files.

Procedure

l Look for log files in these C:\Program Files\APG directory paths.

The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).

Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log

Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet your needs

Procedure

1. Open a browser and type the following URL:

https://<Frontend-hostname>:58443/APG
2. Type the login credentials.

The default username is admin. The default password is changeme.

3. Click Sign In.

Note

You are automatically logged off after four hours.

Connecting to Centralized Management
Connect to the server so that you can access Centralized Management to install and
administer SolutionPacks.

Centralized Management is one of the multiple web applications available in EMC
M&R platform.

Procedure

1. Open a browser.

2. Type https://<Frontend-host-IP>:58443/centralized-management.
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Example:

https://myHost.emc.com:58443/centralized-management

3. Log in.

a. Default username is admin.

b. Default password is changeme.

c. Click Sign In.

After you finish

You are automatically logged off after four hours.
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CHAPTER 7

Automating the Download of Updates

This chapter includes the following topics:

l Online Update overview..................................................................................... 60
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server.

In a multi-server environment, the downloaded modules are distributed to all of the
remote servers managed by the CM server.

Configuring server settings for online updates
Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click Configuration > Online Update .

4. Ensure that you are on the Settings tab.

5. Check the Enabled checkbox.

6. Type your EMC Online Support username and password.

7. Click the  icon to test connectivity to the update server.

The  icon indicates that connectivity to the server has been established.

The  icon indicates that connectivity to the server failed.

8. Click Save.

Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.

4. Click Tasks.

5. Type OnlineUpdate in the Search bar.

6. Click the OnlineUpdate scheduled task.

7. Click Enable.

Note

By default, this task is set to run once everyday at 12AM. You can customize
the task schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.

4. Click Tasks.

5. Type OnlineUpdate in the Search bar.

6. Click the OnlineUpdate scheduled task.

7. Click Run Now.

Online Update Status
The Online Update Status tab indicates whether or not the last online update check
was successful, provides the date and time of the last successful check, and lists any
updates that are available for download.

Figure 1 Online Update Status

If a major update of the EMC M&R platform is detected, the Status tab includes a
Major Update Status section that describes the version that is available, provides a
link to the upgrade documentation, and includes a Start Download button.
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Figure 2 Online Update Status with a major version update detected

Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform.
You should only download a major version if you intend to immediately complete the
full upgrade process.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. Click Configuration > Online Update.

4. Click the Status tab.

5. Click Start Download. When the download is finished, the Download State will
change from "Not Downloaded" to "Complete."

6. Complete the upgrade process as described in the upgrade documentation.
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Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.

The History tab also allows you to search the download history for a particular
component name or version number.

Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.

Procedure

1. Click Administration .

2. Click Centralized Management.

3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.

4. Click Tasks.

5. Type OnlineUpdate in the Search bar.

6. Click the OnlineUpdate scheduled task.

7. Click Disable.
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CHAPTER 8

Uninstallation

This chapter includes the following topics:

l Overview............................................................................................................66
l Stopping EMC M&R platform services on a UNIX server...................................66
l Uninstalling the product from a UNIX server......................................................66
l Stopping EMC M&R platform services on a Windows server.............................66
l Uninstalling the product from a Windows server................................................ 67
l Uninstalling a SolutionPack................................................................................ 67
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Overview
You can uninstall a SolutionPack and uninstall EMC M&R platform from a UNIX or
Windows server.

Stop the EMC M&R platform services before uninstalling EMC M&R platform.

Stopping EMC M&R platform services on a UNIX server
Use the manage-modules.sh service stop command to stop a specific EMC
M&R platform service or to stop all EMC M&R platform services on a UNIX server.

Before you begin

Make sure you have logged in with root or APG privileges.

Note

The list of services varies depending upon which type of installation was performed,
for example, vApp, collector, backend, frontend, and so forth.

Procedure

l Type manage-modules.sh service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.

This example shows how to stop all EMC M&R platform services:

./manage-modules.sh service stop all 

Uninstalling the product from a UNIX server
Before you begin

Make sure you have a login with root privileges.

Procedure

1. Type rm -rf /opt/APG to remove the installation directory.

2. Reboot the server.

Stopping EMC M&R platform services on a Windows server
Use this procedure to stop EMC M&R platform services from the Windows desktop.

Before you begin

Make sure you have logged in with system administrator credentials to manage
services.

Note

The list of services varies depending upon which type of installation was performed,
for example, vApp, collector, backend, frontend, and so forth.

Uninstallation

66 EMC ViPR SRM 4.2.1  Installation and Configuration Guide



Procedure

1. Type manage-modules.cmd service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.

This example shows how to stop all EMC M&R platform services:

./manage-modules.cmd service stop all 

Uninstalling the product from a Windows server
Before you begin

Make sure you have logged in with system administrator credentials.

Procedure

1. Use the Windows Control Panel to uninstall the product.

a. Click Start > Control Panel > Programs.

b. Click Uninstall a program.

c. Select the Watch4net Solutions APG and click Uninstall.

2. Reboot the server.

Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall
that SolutionPack from the server.

Procedure

1. Log in with administrator credentials for EMC M&R platform and select
Administration.

2. Select Centralized Management in the Administration tree.

3. Select SolutionPacks in the tree.

4. Select the SolutionPack that you want to uninstall in the Installed
SolutionPacks screen.

5. In the Properties area, click Trashcan icon for each instance of the
SolutionPackBlock and click Remove.
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APPENDIX A

Telnet and Socket Interface Ports

This appendix includes the following topics:

l Telnet and socket interface ports for each backend...........................................70

Telnet and Socket Interface Ports     69



Telnet and socket interface ports for each backend
The telnet and socket interface for each backend must be different on that backend
host. These ports are open in the Linux firewall setting by default.

Backend Host Backend socket interface telnet interface

Primary Backend
(PBE)

DB 2000 2001

Additional Backend #1
(ABE)

DB1 2100 2101

DB2 2200 2201

DB3 2300 2301

DB4 2400 2401

Additional Backend
#2 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#3 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#4 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#5 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#6 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401
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APPENDIX B

SolutionPack Reconfiguration Fields

This appendix includes the following topics:

l SolutionPack Reconfiguration Fields.................................................................. 72
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SolutionPack Reconfiguration Fields
You can change the settings for the SolutionPack from the SolutionPack
Reconfiguration page.

Table 3 SolutionPack Reconfiguration Fields

Field Description

Socket Collector port On this TCP port on the Primary Backend, the
Arbiter is accepting the remote connections
from all LBCs.

APG Backend hostname or IP address The hostname of the server where the apg
database and its backend service are running.
In this deployment, the possible options are
backend and backend2. Do not use
"localhost" for the default apg on the primary
backend.

APG Backend data port Each APG has a backend and each backend
has its own TCP port to receive raw data. The
port must be unique only inside the server.
Refer to Installing and Configuring the
Additional Backend hosts. In this installation,
the ports are 2000, 2100, 2200, 2300 and
2400.

Web-Service Gateway Each APG server has a Web-Service
Gateway. This hostname must point to the
APG server with the backend service.

Backend Web-Service Instance The backend instance name. In this
deployment, the possible values are:

l Default (the default backend instance
name from primary backend)

l apg1

l apg2

l apg3

l apg4

Backend database type MySQL by default.

Backend database hostname or IP address The hostname where the MySQL database is
running. By default, it is same as the APG
Backend hostname.

Backend database port number The port on which MySQL is accepting
remote TCP connections. By default, it is
53306 .

Backend Database name The database name used in MySQL. For
example, apg, apg1, apg2.

Backend database username The user configured in MySQL. The default is
"apg"
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Table 3 SolutionPack Reconfiguration Fields (continued)

Field Description

Backend database password The default password for the MySQL user is
"watch4net"

SolutionPack Reconfiguration Fields
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APPENDIX C

Unattended Installation

This appendix includes the following topics:

l Unattended installation...................................................................................... 76
l Unattended installation arguments for Linux...................................................... 76
l Unattended installation arguments for Windows................................................ 76
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Unattended installation
EMC M&R 6.7 and higher supports fully unattended installations, which are
particularly useful for installing the software on remote systems via scripts. This
appendix describes the installation of the platform software, but it does not include
the installation and configuration of modules or SolutionPacks.

Unattended installation arguments for Linux

l --silent
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used.

l --accept-eula
Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA.

l --install-dir=<path to installation>
Overrides the default installation location. The default is typically /opt/APG.

l --user=username
Overrides the default user for installation of the servers. The default is typically
apg.

l --script-directory=initd_directory
Overrides the default script directory. The default is /etc/init.d.

l --runlevel-directory=rcd_directory
Overrides the default runlevels directory (containing rc[0-6].d/).

The default is /etc.

l --install-type=installation_type
Overrides the default installation type. The available options are default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
--install-type=C is equivalent to --install-type=collector. The value
of the parameter is not case sensitive.

Example 1  To override the default installation and set the installation type to collector:

[root@server ~]# ./linux_setup.sh -- --install-type=collector

Example 2  To run a fully unattended installation and install as a collector in an alternate
directory:

[root@server ~]# ./linux_setup.sh -- --accept-eula --silent --
install-type=collector --install-dir=/opt/SRM

Unattended installation arguments for Windows

l /S
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used. This must be the first argument.

l ACCEPTEULA =Yes

Unattended Installation
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Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA. The installer will refuse to run in unattended mode if you
have not accepted the EULA.

l INSTALL-TYPE=installation_type
Overrides the default installation type. The available options are: default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
INSTALL-TYPE=C is equivalent to INSTALL-TYPE=collector. The value of
the parameter is not case sensitive.

l /D
Sets the default installation directory. This must be the last parameter. It cannot
contain any quotes (even if the path contains spaces), and only absolute paths are
supported.

Example 3  To run a fully unattended installation and install as a collector in an alternate
directory:

C:\Users\user1> windows_setup.exe /S /D=C:\SRM /
ACCEPTEULA=Yes /INSTALL-TYPE=collector

Unattended Installation
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